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1 CAM350 使用说明 
一、FILE 菜单： 
1、New （NO） 清空原来的所有数据，准备调入新的数据。       热键 Ctrl-N 
2、Open  打开当前及以下 CAM350 版本输出的 CAM/PCB 文件。   热键 Ctrl-O 
3、Save  将当前各层所有数据保存到*.cam/pcb 里。以后打开*.cam/pcb 所有数

据都在里面。                                          热键 Ctrl-S 
4、Save as 将当前各层所有数据另存为*.cam/pcb 文件里。 
5、Merge  可调入预先准备好的模块、添加标识用的 CAM350 PCB 文件，或制

作完的另一个型号的数据的 CAM350 PCB（可用于把几个处理完的资料

拼在一起），调入后用 Edit,Change,EXPLODE MERGED DATABASE，就

可修改模块中的数据。 
6、Import  导入文件 
Autoimport 可自动导入 CAM350 识别的数据文件，包括 274D，274X，*.DPF， 
带刀具的钻孔文件，*.DXF 文件，铣边数据等。数据需在同一目录。 
 不要直接选 Finish，选 NEXT，这样如果软件识别制式不对，还能手动修正。 
 所有调入数据不要只看后缀，需要解读 ASCII 码，来确认数据格式的实质（后

缀是可以任意的） 
Gerber data  手动调入各种制式的 GBR 数据 
如导入数据的 ASCII 码中有 DCODE 定义，都设置为 RS274-X， 
是 *.DPF 则应设置为 Barco DPF，如数据 ASCII 码有 FILE 9* 设置为 Fire 9xxx
调入数据。 

274X、DPF、Fire 9xxx 的都无须再设置公英制及小数点前后有多少位，只

需要告知是 RS274X/DPF/Fire 9xxx 就可直接调入。 
调入不自带 D 码的文件就应设置为 RS274 的，同时要设好正确制式还要能

正确匹配 D 码文件才能显示正确的图形。 
 

如何判别 RS-274D（GBR 数据中无 D 码定义）的制式： 
 一般 GBR 数据是 LEADING，钻孔数据是 TRAILING 的，且大都是绝对坐

标。LEADING 是省前零（补后 0）、TRAILING 是省后零（补前 0）、NONE
是不省 0（前后均补 0） 

例：025690 省前零为：25690 (Leading)  
025690 省后零为：02569 (Trailing) 
025690 不省零为：025690 (None) 

274D 数据首先根据 ASCII 码判断是哪种省零方式 
 其次找到 X 或 Y 坐标之一是相同的一组点，看他们不同坐标的差值。来判

断是公制还是英制（通常此处为单列直插或双列直插器件。） 
如果差 2 一般为公制 2mm，如果是 0.2/0.1 一般为英制 0.2/0.1inch。 

 如是 2，4 解读为 2.5690  如是 3,3 解读为 25.690 
数据读入尺寸偏小，小数点前位数增加一位，小数点后减少一位再读入； 
数据读入尺寸偏大，小数点前位数减少一位，小数点后增加一位再读入； 
 数据读入尺寸是否正确，一般通过检查器件相邻引脚的中心距是否为

0.1”/2.54mm 或 2.5mm 的倍数关系。有尺寸标注也可通过测量值是否一致来

判断。 
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 如果数据导入后外形尺寸、器件相邻引脚中心距也是正确的。但线的粗细、

盘的大小不对。很可能是软件在导入 D 码表*.APT  *.REP 时把单位搞错了。

如英制 D 码单位 1(mil 省略)，解读为 1mm，图形就会糊掉。 
如公制 D 码单位 1(mm 省略)，解读为 1mil，图形就会很单薄，都是细线，

小盘，好多连接的都分开了（如泪滴）这种情况在读入*.PHO 数据时可能会

出现。 
 D 码导入需配相应的 D 码格式解读，并检查焊盘形状方向是否正确，不能有

断线，填充未填实，短路，断路的现象。特别是要注意 X≠Y 的数据（椭院

/长方。。。）其方向解读是否正确，方向反了就会造成短路。 
 圆弧导入如出现异常，有可能是圆弧解读顺时/逆时方向反了，或存在起始/

重点相同的圆弧。 
解决方法： 
软件默认是以 QUADRANT(象限、四分 90 度)读入，如需改为 360 度读入，

请 在 FILE,SETUP,PHOTOPLOTTER 中 的 SETUP OPTIONS 中 选 择 360 
DEGREES。选择 IGNORE ARCS WITH SAME START/ENG POINTS  忽略起始/
终点相同的 ACS。 
 读入 274D 数据后需每一层去检查调入后图形大小、形状是否正确，层与层

之前也要对齐后检查相互关系是否正确。 
 如果软件在自动读入经手动修正制式及 D 码匹配文件后还是不能正确的读

入，且是 D 码问题。看一下每层 D 码之间没有冲突，可以调入 GBR 后，根

据 D 码表手动输入形状和大小，并请另一人进行核对。 
 如果调入的 GBR 文件与当前的设置公英制单位不同，在导入数据时会提示

您是否将当前制式转换到与导入的文件一致，一般选 Yes。 
 针对 PROTEL FOR WINDOWS 软件里设置正八角或长八角的数据，不要直

接输出 274X 的 GBR 数据，因为输出后正八角会成为圆形或转了角的八角

盘，长八角成为椭圆形。 
解决方法： 
取消输出 RS274X 的 GBR 数据（默认为输出 RS-274X，取消此处勾），从

PCB 里生成*APT 数据，检查 APT 中是否存在 OCTANGLE 形状的 D 码，如没

有再输出 RS274X 的 GBR 数据； 
如有请先打印 PCB 线路，并记录下有几种，（线路有阻焊就有，因此看到有

两种大小，且与线路是盘加大成阻焊关系（0.2mm/8mil 0.254mm/10mil）的作为

一种记录）。然后在 PROTEL99SE 中将其形状大小改为 PCB 里形状较少，尺寸

是唯一、特大或特小的，使数据调入后一眼就能看到。（生成的 APT 数据同一种

形状，D 码号及数值都是从小到大排列的）记录 PAD 个数及原本对应的八角盘

形状大小，待输出 RS274X 后，到 CAM350 里再改回。与原始打印稿进行校对，

保证一致。 
不要用 CAM350 调入 PROTEL系列的 RS274-D 的数据，会将 ROUND X=Y

的形状解读为 Oblong 椭圆的，会造成底片光绘后 TRACK 元素的斜线部分变粗

（但看 GBR 文件无异常）  
 注意所有线 都只能是 Round（圆形），Square（方形，且必须是 0/90º的）

其他形状都不允许！ 
 
Drill data  用于导入钻孔数据。同样需要设置好正确的制式才行。 
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 读入后从器件相邻引脚的中心距是否符合0.1”/2.54mm或2.5mm的倍数关系

来判断其正确性。如果位置正确，但孔的大小偏大或偏小，可能是钻孔数据

刀具信息单位与数据坐标本身的公英制不同造成的 
例如钻孔是英制的，刀具信息是 0.9,1.0,1.1(mm 省略)，软件会理解为

0.9,1.0,1.1 Inch(很大的孔)，只需将其换算为 0.0354,0.03937,0.0433 就正确了。 
 如果是*.pho,*.rep 的数据，通常 GBR 用英制 2，5，Leading 调入，钻孔用英

制 3，5，Trailing 调入。 
Mill data  用于导入铣边数据。 
 
Dxf    用于导入*.dxf 数据，一般 mm DXF----CAM350 为 1:1 导入。 
 如果客户是放大 10 倍设计的，导入时应缩回到 1：1 读入，此时在

DXF----CAM350 处输入 1:10  就行了。（可理解为 1/10） 
 

DXF 参数默认设置更改： 

Arc settings in polygon Borders: 

√ sectorize Angle: 1º（原为 5º默认值）保证圆弧不失真。 

Text width: 0.1mm（文字）    Line width:=0.2mm（非填充的单跟线） 

Flash circles less than 将≤此值的环转换成 PAD 的形式。 

其余都是默认值  注意 CAM350 字体不同于 dwg 文件，而且不支持汉字，

除非选了与 DWG 一样的字体，否则字的位置会改变！！！ 

 通常从客户原版本 AUTOCAD 中输出 PLT 数据（7586b）以 HPGL 格式调入与

CAM350 调入的 DXF 文件进行比较，检查有无图形失真的情况。 

Aperture table 当导入的是不带 D码的 GBR 文件时需要在导入正确制式的 GBR 

文件后，再导入 D 码文件。才能显示正确的图形。 

 待 274D 数据正确导入后需输出 274X 格式，作为后面修正后校对稿，起到检

测修改有无违反原稿意图的作用。 

 数据正确导入后，请先保存未改动时的原稿。文件名体现型号和 YWJ，例如

取名为 EDI7589-YWJ.PCB/CAM。 

 

7、Export 导出文件 修改后数据输出不能覆盖原稿！且从文件名上区分！ 

Gerber data  导出 GBR 文件，带不带 D码都可以，但通常都是导出带 D码的。 

 注意输出文件的制式必须要保证原来的精度，只能高不能低。导入导出文件

公英制保持一致。 

Composites 导出由两层及以上合成的复合层。 

 如果是复合层，却选 Gerber data 输出，那么只输出第一层，后面的复合层

都没输出。 

 导入文件如果是复合层文件，导出也必须用 Composites 输出复合层文件。 

 有宏 D 码 PAD 的必须用 Edit,Explode,Custom，ALL 打散输出，避免光绘机

解读数据图形错误！ 

Dill data  导出钻孔数据 

Mill data  导出铣边数据 

Dxf  由各层 GBR 数据导出 DXF 数据，（AUTOCAD 就可调入） 

Aperture table 当导出 RS274-D 的 GBR 文件时，还要导出与之匹配的 D码文件。 

8、Print  打印文件 
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Setup printer 设置打印机;如已安装 Adobe 软件,可直接输出 PDF 图片数据 

Print display 打印预览 

Print 只打印开着的层。将选√的文件打印逐个打印要选 Separate sheets   

可居中、旋转、镜像、按纸张大小放大、缩小打印。 

8、SETUP: 

   preferences   

中设置允许 UNDO 操作， 

创建备份目录， 

圆弧导入保证数据原样， 

设置宏 D 码打散为哪种形式（一般为 PLOYGON）， 

设置自动备份及每隔多少分钟自动备份。 

 自动备份比较有用，可减少和避免软件中断，电脑死机数据未存盘而造成的

CAM 损失，但 SAVE 后之前的就不能 UNDO 了！！！ 

  path  设置数据输入输出的目录，调入库文件、脚本所在目录 

  file Extensions 设置输入输出各种数据的默认后缀 

FILM BOX 可设置 底片最大值，0点，并显示出来 

PHOTOPLOTTER 设置输入输出数据 ASCII 码的识别码，正/负向量数据极性等 

DRILL 和 MILL MACHIN  设置输出钻孔和铣床数据时加的文件头及相关信息。 

SAVE defaults 改变设置后保存，以后打开 CAM350，相关参数都是设置变化

后的。  

Licensing  可查看是否所有功能都能使用，完全解密了。 

 

二、Settings 菜单： 

1、 Unit 设置公英制单位和精确度（小数点后保留位数），需与导入文件制式配 

         否则测量值精确度不够，鼠标移动也不流畅，感觉是一格格的动。 

2、Text  在添加字符前首先要设置字体、字高、方向、正字/反字 

3、View options  设置查看选项，选择 VIEW MERGED DATABASES, VIEW CIRCUIT 

IMAGES 就可看到加载和虚拟排版的整个数据。 

4、Arc/Circle  设置圆/弧的默认值 

 

三、Tables 菜单： 

1、A pertures  快捷键：A   

点击 used only 显示所有文件使用到的 D码情况（包括宏 D码） 

如果要新建 D码，则右方 Dcode 栏内输入一个未用 D码号，下方设置好形状大小 

Enter,OK,就可供使用。 

Compress  删除未用到的 D 码，将用到的 D 码排列在一起。 
2、 Layers  快捷键：Y 默认数据属性为 Graphic，如果一套完整的数据（GBR

和 DRL）需要生成网络做 DRC 检测的，那么应设置好层的属性。线路顶层定

义为 Top，底层定义为 Bottom，内层是信号层定义为 Internal，内层是花盘

层定义为 Neg plane。阻焊(Mask top/bot、字符（Silk top/bot）、外形层

定义为 Board 都要定义为相应的属性才行。后续 DRC 及部分优化操作都是在

此基础上完成的。 

 可以更改显示颜色（左）线和（右）盘的颜色设为不同，Act 指明当前操作

所在层，Data 指明哪些层有数据，哪些是空层。Status 指明层开着哪些层
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关着没显示。 

 可将某些层设为 REF 锁定层,会显示此层图形,但操作时不会对其进行操作. 

 后续的规则检测中所提示的 PAD 都必须是 PAD 形式，而不是线构成的盘，连

线从 PAD 中心连出，否则检测结果会多出很多未达标的信息。 

因此必须将线路和阻焊上的盘都转为 PAD 形式，使用 DRAW TO FLASH 完成。 

3、 Composites  如果导入的 GBR 数据是有复合层的，那么在此会显示出来有哪

几层以及层的合成情况。如果自己需要重新合成一层的，那么 Add，输入合

成输出的数据文件名，按先后顺序进行层叠加，Dark 是正向叠加层，在前，

Clear 是切割层，在后，OK。 

 千万不要再 SETUP,PHOTOPLOTTER,中选择数据导入时自动将数据合成单层。

那样的话，线、盘都以 POLYGONG 的形式存在，无法在做精确测量和 CAM 处

理。 

 

四、View 菜单：滚动鼠标中键上下翻屏,按住中键并拖动鼠标：向上 放大向下

缩小 

1、Window （热键 W） 局部图形放大查看。W键可与许多操作指令配合使用（框

选需要编辑的数据，框内框外切换热键是 I） 

2、All （热键 Home） 查看整个图形 

3、Redraw (热键 R)  刷新界面，显示完成指令后的图形。此图标在外面就有。 

4、In  （热键+）  以鼠标所在位置放大显示图形 

5、Out （热键-）  以鼠标所在位置缩小显示图形 

6、Pan  （热键 Insert） 平移显示，此项用于逐屏检查，注意技巧。 

7、Composites  只显示 Table 菜单里当前的复合层，与在 Table 菜单 Composite

里选择某一复合层 Redraw 效果一样。 

8、Back  side  显示当前图形的镜像效果，如此时存盘还是与原来一样未镜像。 

9、Rotate  显示旋转角度后的图形，如此时存盘还是与原来一样未旋转。 

10、Tool bar  显示工具条（显示格点，当前 D码，当前层的工具条） 

11、Status bar 显示状态栏 （最底下的一栏，告诉你现在在执行哪条指令，并

提示您应如何操作下一步） 

12、Layer bar  显示图层条，有 Redraw,Add layer,All on 显示所有层，All off

除了当前层都关闭。点到哪层就是当前层，左是线的颜色，右是盘(Flash)颜色。

鼠标右键可设定颜色，还可关闭线或盘再显示。 

13、Message bar 显示对话框，这栏通常关闭。 

14、Shortcut bar  开关最左 shortcut 一栏，不习惯这栏可关掉，因为这些指

令在大菜单里都有，单独列出只是为了使用方便。 

15、Dash board  与 Tool bar 一样。 

 主菜单下方是一排快捷键。鼠标放在这图标上会告诉你代表哪些指令。其中

有三个点状图标从左到右分别是自动捕捉线盘中心（OBJECT SNAP），热键 Z、

鼠标走格点热键是 S、显示格点，热键是 V。这几个热键是相应功能开启/关

闭的切换。按 F 有三种视图，实体、外框、中心骨架。T可透视看图。 

 OBJECT SNAP  经常用于精确测量，移动，拷贝时定义精确的基准和相对位

置。 

    透视显示 可用于两层比较不同处，颜色一致时图形一致。 

高亮显示 可高亮当前 D码，确定需要更改的数据分布情况 
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五、Info 菜单：未写几项在 CAM 里不常用 

1、Query 查询图形属性，可读出所选一个盘/一根线的 D码号，形状、大小，所

在层。 

Net 如已生成网络就可查询当前网络信息（显示所选网络构成的连接点位置） 

Dcode 显示所选元素的所有信息，且工具条里当前 D码会变为此 D码。 

2、Find   
DCODE  找出并高亮当前 D码 

NET    找出并高亮当前网络的所有数据 

3、Measure 测量距离，有三种方式 

Point to point 测量盘到盘中心,线到线中心的距离 

（必须打开线端点/盘中心捕捉器 按 Z） 

Object to object 测量盘与盘、线与线的间隔 

Net to net 测量网络距离，不常用 

4、Report 报告 

Dcode 显示所有层/每一层的 Trake 和 Pad 的 D 码使用情况 

 用于逐层检查有无长方形、椭圆形等不符合 Track（圆形和正方形（且正方

形线都是 0和 90°的））正规形状的。 

 检查文字层有没有小于印刷值的 D码，便于后续做针对性的编辑。 

Nc tool  显示钻孔报告 （孔径顺序、大小、个数） 

5、Status  显示版本、调入数据的最大尺寸（关着层也算在内） 

 

六、Edid 菜单（在选数据的时候同一位置开着的层都会选上的） 

1、Layers 层操作 
Align,先选择不动层上的 PAD 上点左键，再点右键确认该点，再在要移动层上（钻

孔层）的相应位置点左键该点会变白，双击右键就对齐了。 

Add layers  增加层，在左边工具栏内有块捷按钮。 

Remove 删除层，按 Compress 可自动识别无用层，OK 就删除了。 

Reorder 重新排列层，通过鼠标来调整，OK 就行了。 

Snap pad to pad  将焊盘与焊盘对中，要设置偏差多少范围内做对准移动。最

上一栏内层是基准层。下面各层如 √，就是选中要移动 PAD 的层。 

Snap pad to drill 将焊盘与钻孔对齐。移动盘所在层，钻孔层不动 

Snap drill to pad 将钻孔与焊盘对齐。移动钻孔层，PAD 所在层不动 

 通常自己从客户设计的CAD文件输出GBR和钻孔数据必须保证公英制及精度

一致性，如 GBR 数据输出 Leading,Inch 2,5，钻孔数据输出 Trailing,Inch 

2,5，避免人为造成钻孔与 GBR 数据因为制式不同造成偏差。 

且一般以线路 PAD 为对位基准，因为如以钻孔为对位基准，那么线路、阻焊

PAD 位置都需要调整。 

Scale 比例，用于层的缩放比例，注意 D码大小是不变的！！！ 

PAD 指 盘形式的，非线构成的盘。 

2、Undo （U） 撤消，返回上一步。 

3、Redo  (ctrl-u)  如果 undo 用错了，可以用 redo 恢复。 

4、Move  选择 move 命令后，选 Sellet all 是全选，如按 W 是框选，按 W 后再
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按 I 是反选，不按键就是单选盘/线，右上角还有按某种条件移动的过滤器（例

如输入要移动的 D 码号，多个用逗号隔开），反复直到选完要移动的数据按右键

确定，再定义移动基准点，目标位置有几种。按右键确定并完成指令。 

A）、Move to layer 移动到其它层上可是一层也可是多层。 

B）、按角度移动  左上角 L 有 L0,L45,L90 是角度，在同一层里移动到鼠标所在

位置，左键确定（可 N 次直到最终确定）位置，按右键确定并完成移动指令。 

C）、按指定坐标位置移动。在同一层里移动。双击右下角的坐标，可键入绝对坐

标，也可按相对位置移动。 

5、Copy  选择 copy 命令后，选好需要 copy 的数据，再选好基准点，目标位置

有几种。按右键确定并完成指令。可配合框选及过滤选择所要操作的数据 

A）、Copy to layer  复制到其它层上可是一层也可是多层。 

B）、默认只再 Copy 1 个。可结合角度，用鼠标告知目标位置（相对、绝对位置）。 

C）、Copy 个数是不包含本身的，1 为再要 Copy1 个，如 Copy 后是 6 个，输入为

5,而且 X、Y 方向每次只能 Copy 一个方向。不能一次阵列完。通常这种 Copy 都

是以告知相对坐标来 Copy 的。 

6、Delete  删除所选的数据，按右键确定并完成指令。可配合框选及过滤选择

所要操作的数据 

 如果在删除时，不小心选取了不要删除的，这时按 CTRL+鼠标左键点击不需

删除的部分，即可恢复！ 

7、Rotate 将所选数据旋转角度，有几种角度可选，也可自己输入角度(小键盘)。 

  可配合框选及过滤选择所要操作的数据 

8、Mirror 镜像所选的数据。Vertical 是 X 轴镜像，再按一下变成 Horizontal

是 Y 轴镜像。可配合框选及过滤选择所要操作的数据 

9、Change 在这里可重新设定每个元素的 D码，字体大小，样式，坐标原点等。 

   可配合框选及过滤选择所要操作的数据 

1）、Dcode  更改选中的某一种元素的 D码 

 一般改为新 D 码，以避免其他层用到此 D 码而在未知情况被改变。而且新 D

码必须是存在的。（事先要添加好新 D码再改） 

2）、Text 更改字符 

Font 仅更改字符的字体 

Style 仅更改字符的字体，大小，方向等 

Text style and contents 更改字符的字体,大小,方向,内容.通常用此项。 

3）、Explode  
CUSTOM 打散宏 D码（自定义的 D码） 

一般不选任何 DCODE，打散为 Ploygon 

MERGED DATABASE 打散 MERGED 进来的 CAM350 的 PCB/CAM 数据 

Vector polygon  打散之前 ADD PLOYGON 后的 BLOCK（块） 

Text 将字符串打散成每个字符变为一个 Surface 

4）、Sectorize 将圆弧打散成由小线段构成  

    对于能够接受圆弧描述的光绘机最好采用圆弧描述。这样做 Gerber 文件数

据量小，光绘圆弧边缘光滑。 

5）、Origin 设置坐标原点  不要随意改变，此操作不能 Undo！ 

Space origin 绝对原点 

Grid origin  网格原点 
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Datum coordinate 数据坐标 

Panelization anchor 排板原点 

10、Trim using 修剪当前的线元素（圆弧必须先要打散），用于剪切掉线段一部

分。 

   操作时先要用左键拉出修剪的分界线（与被切数据成垂直方向），可多选，右

键确定，再左键点选需要修剪掉的 Line 部分。 

Line 通过一条线作为修剪的分界线 

Circle/Arc 通过圆或弧作为修剪的分界线 

11、Line change  线的更改 

1）、Chamfer 直角倒成 45º角 Backoff 是半径，Min angle 为倒角最小角度，用

小键盘数字设定完按左键执行。 

2)、Fillet 直角倒成圆角 操作同倒折角。 

3)、Join segments 可合并多段连续线段为一根连线，移动时，单选，可一起移

动。 

4）、Break at Vtx 在连续线段拐点处打断，可移动连线中的一根线段。 

5）、Segments to Ares 折线转圆弧 （不太好用） 

12、Move Vtx/Seg 移动一根线的线头，两连接线段的拐点，或三段线构成的中

间那根线段。 

13、Add Vertex 增加端点可改变线段走向 

14、Delete Vertex 删除拐点 

15、Delete Segment 删除线段 

 CTRL-鼠标左键  在执行 MOVE、COPY、MIRROR、ROTATE 时，如不能使用框选

选中数据的情况下，不断加入要操作的数据。 

 过滤器（filter）： 

1. Dcodes 用来筛选 D 码。 

空格表示所有都有效，只要层的状态是打开都可以被编辑。 

键入 10，20 表示只有 10 和 20 号 D 码才能被选中编辑，其他的 D 码就被过滤

掉了。 

键入-10，表示除了 10 号 D 码以外都可以被选中，10 号 D 码就被过滤掉了。 

键入 10：20，表示从 10 号 D 码到 20 号 D 码都处于激活状态。 

键入-10：20，表示从 10 号 D 码到 20 号 D 码都被过滤掉了。 

2. Tool References 用来筛选刀具。 

3. Tab Ids 用来筛选 Tab 位（即连接位，锣带里才用的到）。 

七、ADD 菜单： 

1、 Flash 用当前 D码在当前层在指定位置添加 PAD（D 码必须是已存在的）。 

2、 Line 用当前 D码在当前层指定位置添加线，可配合角度、相对坐标位置来加。 

3、 Polygon 增加多边形填充。常用有 Raster(光栅填充)和 Vector（线填充）

两种方式。可设定填充内容到边框线的距离，注意填充边框必须是封闭的。 

 不选 Fill to board 否则即使设置到边框线距离也没有用。 

 Vector 可用于填充成网格，电镀边，阻流边，导流点，板边加强铜箔块。 

选 AREA FILL ,VECTOR, 

1、SOLID，用指定 D码线填实 

2、HATCH，填网格线。具体操作： 

设置 Outline Dcode（所填数据的边缘线，必须要>=内部填充线粗，否则边
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缘会有突起） 

Ploygongclearance（内部填充部分到封闭区域框线的边缘距离） 

设置好填充线宽、Step、角度、保存设置为*.PAT，OK，鼠标左键在填充框

内点击一次 就完成了。 

 LINE1,2,3 网格线粗和角度（如第三种线不需要可设为 0）。 

3、DCODE，常用于填充内层板外导流点（只能是 ROUND）OFFSET 是错位，两

排点大小可不同，Y-STEP 是 Y 方向相邻点中心距。 

 HATCH 和 DCODE 方式，需先设置好填充方式，保存为*.PAT(填充模式)，点选

所填封闭区内任意位置进行填充。填完数据是一个 BLOCK 。用

Edit,EXPLODE,Vector polygon 打散后可查看填充线和边缘线等都是按设置

完成的。 

4、 Polygon void  在原来的 Raster Polygon 自动填充里切掉一部分。 

5、 Text 添加字符。首先要在 Setting，Text 里设置好字体、方向、大小，对

齐方式等，然后在 D 码列表中设置好合适的 D 码，在层列表中设置加在哪一

层，然后 Add，Text，输入字符内容，左键确定。不支持汉字。 

6、 Rectangle 增加方框 

7、 Circle 增加圆 

8、 Arc 增加弧 

9、 padstack 是由一个孔及其连接的各层焊盘所组成的一个电性组合生成网络

后就有了，可以用 query， padstack 来查看原有 gerber 的 padstack，然

后再指定位置添加此 padstack。 

八、Utilities 菜单： 

1、 Draw to custom 生成宏 D码 PAD 

 将一些线/一些盘/一些线和盘 一起转为宏 D码 PAD，可是任意形状的，并记

录 D码号。 

 可创建角线、特殊形状定位等为宏 D码 PAD，如在 Tools,Cap editor 中保存

相应 CAP 和 LIB 数据（类似与创建后存到软件数据库中），那么做其他资料

时都可使用。 

 也可用于修改同一种文字层的器件框。方法为先手动优化好一种器件框，然

后将其生成宏 D 码 PAD，记录 D 码号，用 Draw to flash 转成此 PAD，然后

将同一种器件框用 Draw to flash 转成此 PAD（允许 0 和 90°同时变）。很

方便。注意操作之前先拷贝出数据到新层，待修改后进行校对。 

 用此方法修改的器件框一定要将其打散，以防下此打开资料时 D 码会旋转。 

2、 Draw to flash  用 Interactive 转换为 PAD，一般误差为 0，允许旋转 90

度的同种也一起转换；如果怕转换后方向错误，不允许旋转器件一起转换。 

Define by size and shape of dcode  

直接转换为相应数值的圆/方/椭圆形 PAD，形状要选正确！ 

   Define by selecting dcode    

配合Pick from list 可直接转换到制定的已存在的Dcode形状大小。 

   Define by creating a custom aperture 

          创建一个宏 D码 

 也可配合 Draw to custom 替换同类型的数据为指定宏 D 码，例如文字器件

框的优化，替换周期等 

 转成已创建的宏 D 码 PAD 时，软件是以最大（X 和 Y）值来转的，如器件框
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内有标识方向的数据，软件不会识别，会导致转换后与原稿不一致。因此完

成此操作后必须与原稿用 Compare Layer 进行校对，并修正。 

 也可用于将同类型线构成的盘转成 PAD 的形式。 

3、 Polygon conversion 大面积铜填充方式转换 

1)、Draw to raster poly 线填充方式转换成自动填充的方式。 

2)、Raster poly to vector poly 将自动填充方式转换成线填充的方式。 

4、 Netlist Extract  生成网络 

 在做此操作前，须完成对钻孔层的 CHECK DRILL 和优化（检测重孔、偏心孔、 

孔距近的，删除重孔和偏心孔，对孔距近的向接单者反馈是否允许移动再操作）。 

整层对齐,线路上钻孔盘转为 PAD 形式，做 Snap Drill to Pad 微调孔与 PAD

对齐，定义好各层(GBR 和 DRL、外形层)的属性后,全选生成网络。 

偏心的孔是无法生成网络的！ 

只有正确生成网络，才能得出正确的 DRC 报告！ 

5、 Clear silkscreen 切割字符层。告知字符层、阻焊层，在 Clearace 里输入

字符不上盘的距离（单边距离），会在新层上生成新的字符层。Min. stub 

length 如输入 0.2mm，那么如果被切后不足 0.2mm，就不切了。 

6、 Data optimization 数据优化 

1)、Remove isolated pads 删除孤立盘，但注意不要造成断线、开路。 

    预先要备份一层以便核对效果！ 

2）、Remove redundant pads 删除重叠的盘，按 F可看到大盘套小盘。 

7、 Teardrop  在保证线到线，线到盘，盘到盘间隔的情况下，增加泪滴以增加

线和盘的接触面积，降低因开路造成的报废。 

 从 PAD 引出的那条线还需够长，且是从 PAD 中心引出的才能加得上去。 

8、 Over size 选中范围内的所有数据统一 加大/减小盘和线的大小，会重新生

成新的 D 码，不会改变图形的位置。 

尺寸是直径加大或缩小的值，还可按百分比变化，如加大 25%，应输入 125。 

9、 Panelization 排板编辑器，可虚拟拼板。达到改动一块，拼板数据会同时

改动。进入 Panel Editor 进行排版：（07/1/5） 

1） Setup：设置排版尺寸最大限制/开料尺寸，OK 

2） Creat： 

可设置 Panel size，必须大于拼版后尺寸。 

用 Border Spacing 设置拼板后四周到 Panel size 的留边，如忽略此

项，请在 Comput 栏中此项后点击一次。 

Image Rotation 按逆时针旋转后拼板 

Spacing：可设置拼板间隔， 

Between 是按外形的最外边到最外边（或以小块数据的最大尺寸

为拼板依据） 

Offset 是以拼板之间的中心距为拼板依据 

Number of X Copies：X 方向拼板后个数 

Number of Y Copies：Y 方向拼板后个数 

设置好按 Creat，就完成了。 

3)Venting：可对拼板之间，拼板和 Panel size 尺寸之间进行覆铜。 

 设置好单位， 

Offset from panel edge 从 Panel 框向内多少开始填 
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Offset from Images 向内填到里面图形外单边多少 

Offset from Symbols 让开废边上定位点，光学点。。。多少填 

在 PATTERN 里设置填充方式 

Solid Pattern 用光栅形式实心填 

Dot Pattern 用圆点或方点填（圆点可用来填内层废边上的导流点，方点可

用来填外层线路废边，作为加强铜箔） 

Hatch Pattern 填成网格线 （内外层线路都可以用，内层疏，外层密） 

 必须在 Panel editor 界面输出排版后数据，File，Export Panel，输出排

版后的 Gerber（单层/复合层）、DRL、DXF、MILL 等。如果在主菜单界面下

输出，只能输出单块数据。 

 一个型号排版器只能使用一次，不能做到对单块进行虚拟排版成一连片，再

将其虚拟排版成大拼版工作片。 

 也可输入开料尺寸，限制拼板后尺寸到开料尺寸的留边（包括定位、角线等），

自动排版，看哪种角度放置拼板个数较多。 

10、Convert composite 将复合层逐一在新层上合为一层。例如文字用阻焊切

割，用此命令将复合层变为一层，且都是 Surface。 

11、Composite to layer 复合层在新层上合为一层。 10 和 11 功能差不多。但

是同样是将文字用阻焊切割后的复合层变为一层时，只有被切割到的地方变为

Surface。  

经过转换后需要重新定义好各层的属性，作 DRC 时很有用的。 

九、Analysis 菜单：对于与电性能的相关检测，需要先要所有层对齐，将线构

成的盘转化成 Flash 盘，生成网络再进行这一菜单的操作。 

1、 Acid traps 找出同一网络距离太小或角度小于要求值如钝角的铜线并优化。 

用于填掉小于设定值的细缝！需要配合角度的设定来完成。角度为 0~90 之间，

角度越大，修正的尖角就越多，而水平的细缝，只要在设定的值范围内就可以

补掉的。 

2、 Copper silvers 找出不同网络间间隔小于指定值的线路,高亮指出不优化。 

 ACID TRAP 它是查板子上铜泊中有无小的未填充，可以自动修复（Ｆix Acid 

Traps） 

 COPPER SLIVERS 是查铜泊中的小狭条空洞，因为它们的面积可能比较大，

但是间距太小，Acid traps 无法查。 

3、 Mask silvers  找出间隔小于指定值的阻焊细缝，并填掉。 

4、 Find solder briges 找出阻焊之间间隔小于设定值的地方并高亮显示。 

用于检查绿油桥。 

5、 Find pin holes  找出小于设定值的空洞并填掉，是切线关系做底片有细缝。 

6、 Plane checks 内层检测（internal 是信号层，Neg plane 是花盘层）检测

出 thermal 盘开口大小是否符合要求，以及由于相邻 thermal 盘、隔离盘位

置大小的影响造成短路或断路等。 

7、 Silk to solder spacing 找出丝印到阻焊的间隔小于设定值的地方。 

8、 Solder mask to trace spacing 找出阻焊到线路间隔小于设定值的地方。 

9、 DRC 设计规范检查 

Layers to test 选择需要检测的线路 

在 Clearances 一栏里逐一设定好要检测的设计规则：线到线、线到盘、盘到盘、

外形到线路、设计允许的最小线宽值、最小焊盘等。点击 Run 键，选好检测数据
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范围，检测完打开 List view，按 Next 逐一看到每处检查结果。 

Annular Ring  

Pad-mask 检测阻焊与线路环比是否达到规范要求。如设定为比线路单边大

0.15mm，实际只有 0.1mm。 

Drill-mask 检查阻焊与孔的环比是否达到规范要求。 

Drill-pad 检查线路环宽是否达到规范要求。 

Special checks 还可检查孔化孔、非孔化孔到铜箔的距离是否达到规范要求。 

10、Nets  网络检测，针对当前图形与原生成的网络做开路检测，即两层不在同

一网络的 Plane（内层）不同时为 Thermal 状盘确保不短路。 

11、Copper area  计算沉铜面积：0.0127mm,645 sq mm,选中 compute with drill 

information，输入板厚,计算结果为 X： 

X=（线路图形面积+（孔壁表面积/2）-孔面表面积）， 

用 X+（板边缘表面积）/2=X+（（板长+板宽）*2*板厚）/2 

= X+（板长+板宽）*板厚 

= 电镀面积 Z。 

 沉金就是算阻焊层面积，镀金就是算线路层面积。 

12、Compare layers 层比较，用于文件自检。 

13、Check mill 检测铣床数据。检测外形补偿与实际宽度或弧度是否有冲突。 

14、Check drill 检测钻孔数据是否有重孔（会删除较小的孔）、叠孔、孔到孔

的距离是否符合设计规范。 

 偏心孔要手动删除，孔距近的手动做修正。 

十、Tools 菜单： 

1、 Cap editor 建立或修改一个自定义 D码，后缀为 clb。 

2、 Flying probs editor 飞针测试编辑器 

3、 Bed of nails editor  针床编辑器，即电脑测试架 

4、 Part editor  建立或修改一个新的器件，后缀为 plb 

5、 Nc editor 数控钻、铣编辑器，用于 NC 数据的制作生成。 

进入 Nc editor，再选 Utilities: 

Gerber to drill 从 GBR 数据生成钻孔数据。 

 例如客户无钻孔数据，只有钻孔图，需要根据钻孔图提供不同孔的形状大小，

用 Draw to custom 和 Draw to flash 逐一将同一种钻孔符号转为宏 D码 PAD。

然后再按钻孔孔径改好钻孔值。 

如果不同钻孔的钻孔符号一样，就只能从图形盘提取位置（可将线路上 PAD  

COPY 到新层上），然后按钻孔图正确设置钻孔孔径。 

然后用 Gerber to drill 生成钻孔数据。 

Gerber to mill 从 GBR 数据中提取外形数据，再生成铣床数据。 

Nc data to gerber 将钻孔数据转换成 GBR 数据，可在 GBR 状态下对其进行

编辑。 

 TOOLS ，NC EDITOR 菜单，结合 Edit,Add,Info 等命令可对钻孔数据、铣床

数据进行编辑。 

ADD ，DRILL HIT 增加钻孔，DRILL SLOT 增加槽孔 

 在 CAM350 里做铣边：路径必须是封闭的。 

第一步：先把外框转化为锣带（同時先把刀具设好） 

第二步：选定如何走 
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13 
第三步：导出。 

即 Tools -> Nc Editor -> Utilities -> Gerber to Mill 点击 OK，再点击

确定，出现 Mill path properties 对话框，设定进刀速、走刀补偿，在 Tool 

table 中设定铣刀大小。最后导出就可以了。 

 更改铣边下刀位置： 

Tools -> Nc EDITOR Edit -> Change -> Mill Path -> Plunge/Extract 

操作完，按右上角 Return to cam editor 回到原先 GBR 数据编辑状态。 

 输出钻孔时会自动删除重孔 

 用指令编辑或修改钻孔资料时，一定要在钻孔编辑状态下。 

添加菜单 -- Add ： 

Drill Hit 钻孔 

Drill Circle 扩孔（G84） 

Drill Slot 钻槽（G85） 

Drill Text 钻文字（M97、M98） 

Mill Path 铣路径（G01） 

Mill Circle 铣圆（G32/33） 

Mill Slot 铣槽 

Mill Tab Tab 位（中断） 

这些选项都是在初期使用的比较多，等用刀相当熟练后基本上是通过 Gerber to 

mill 项来自动转换的，配合 edit 菜单来修整，不需要通过 Add 来一点点的手

工添加。 

Utilities ： 

Gerber To Drill  转钻带 

Gerber To Mill   转锣带 

NC Data To Gerber  NC 数据转 Gerber 

Create Drill 生成钻带（做电测时用） 

Offset Mill Path 路径偏移 

Segregate Drills 钻带隔离（区分 pt 和 npt 孔） 

Sort Drill Hits 钻孔数据优化 

Sort Mill Paths 铣边数据优化 

Step and Repeat Image Order 设置重复排版次序  

图表菜单 -- Tables： 

Layers 层菜单（快捷键 Y） 

Assign Tool Table to Layer 指定刀具表对应层 

Define Mill Tabs 定义 Tab 位 

New NC Tool Table 新建刀具表 

Delete NC Tool Table 删除刀具表 

指定刀具表对应层是一个比较重要的选项，如果是通过 Add 菜单来手工添加的

话，一定要先新建刀具表，在指定刀具表对应层（将层属性改为 NC 属性），才

能顺利添加数据 

十一、Help 菜单： 

Hot Key 一栏综合了所有快捷键，可做参照。 

其他技巧： 

1、在菜单栏空白处，单击鼠标右键，点 customize 进入。选择 keyboard 选项，
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14 
在 Category 里选择命令所在的菜单，在 Commands 里选择命令,在 Press New 

Shortcut 里输入你所要定义的键，点击 Assign 完成。可设置任意快捷键。 

2、可以用 macro 下的 record 自动记录过程式，形成一些更实用的 scirpt。 

3、当客户未提供钻孔文件时，除了可以用孔径孔位转成钻孔外，还可以用线路

PAD 转成钻孔文件。当孔径孔位符号之间相交不易做成 Flash 时，或未给出

孔数时（一般指导通孔），用以上方法比较好。先将线路上的所有 PAD 拷贝

到一个空层，按孔径大小做 Flash 后将多余的贴片 PAD 删除后转成钻孔文件

即可。（GERBER TO DRILL） 

4、当防焊与线路 PAD 匹配大部分不符合制程能力时，可将所有线路 PAD 拷贝到

一个空层，用此层和防焊层比较将多余的线路 PAD 删除，接着将此层整体放

大 0.2mm（整体放大或缩小：Utilities-->Over/Under），最后将防焊层的锡

条或块（大铜皮上的）拷贝过去即可。用此方法做防焊一定要与原始防焊仔

细校对，避免多防焊或少防焊。 

5、当资料有大面积铜箔覆盖，线路或 PAD 与铜皮的距离不在制程能力之内，且

外型尺寸又较大时，可用下列方法快速修整线路或 PAD 与铜皮的间距： 

A)将线路层的所有 PAD 、非大面积铺铜、单笔宽线路分别 MOVE 到不同空层，

即只剩下大面积铜箔，此为第一层。 

B)将 PAD 再复制到新层上。在新层上将对应在大铜皮上的 PAD 删除，再将剩

余 PAD 放大做为切割大面积铜箔（即第二层切割第一层）。 

  如单笔宽线路到铜箔距离也不够，也采用相同方式去切割大面积铜箔。 

C）然后将原线路层的所有 PAD 、非大面积铺铜、单笔宽线路作为第三层 

合层方式为：第一层（加层）、第二层（减层）、第三层（加层）。 

为了减小数据量，因此第一层只保留大面积铜箔。 

6、如果只是防焊到大铜皮的间距不够，就可以把放大后（满足制程能力）的防

焊拷贝到一个空层，把对应在大铜皮上的防焊删除，再将剩余防焊放大切割

大面积铜箔。 

用上述此方法做好的线路，一定要用 Utilities-->Convert Composite 将其转换

为一个层，然后与原稿用 Anglysis-->Compare Layers 命令进行仔细核对。 

7、如果需要在线路上体现钻孔中心孔，可将与线路 PAD 校准好中心位置的钻孔

数据用 NC DATA TO GERBER 转换成 GBR 数据，并将其统一改为厂内指定的大

小，然后作为第二层（挖线路）与线路合成复合层输出即可。 

8、所有输出光绘的数据，都要在输出后且未退出输出前设置状态重新调入，与

软件中数据校对，以保证不存在任何输出过程出现异常造成的数据错误。 

 

 

CAM350 支持的 D 码形状 

Round： 圆形   Square： 正方形   Rectangle：矩形   Bullet:类似半圆形  

Thermal：花盘（多层板内层导通盘/连接盘）    Custom： 自定义 D 码 

Donut： 甜甜圈（外径必须大于内径）  Butterfly  重合对位检测符 

Octagon： 正八角形和长八角形（不能旋转） Target： 单体靶标 

Oblong： 长椭圆形    Ellipse： 椭圆形   Morie：多重环形靶标 

Triangle： 三角形    Hexagon： 六角形   Diamond： 菱形 
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Gerber 文件介绍 

Gerber 文件的格式： 

RS-274-X （常用） 

RS-274-D/RS-274 （常用） 

Fire 9000 

Barco DPF 

标准的 gerber file 格式可分为 RS-274 与 RS-274X 两种，其不同在于： 

RS-274 格式的 gerber file 与 aperture 是分开的不同文件。 

RS-274X 格式的 aperture 是整合在 gerber file 中的，因此不需要 aperture

文件(即内含 D 码)。 

数据格式：整数位+小数位 

常用：3：3（公制，整数 3 位，小数 3 位） 

2：4（英制，整数 2 位，小数 4 位） 

2：3（英制，整数 2 位，小数 3 位） 

3：3（英制，整数 3 位，小数 3 位） 

 一般 GBR 数据是 LEADING，钻孔数据是 TRAILING 的，且大都是绝对坐

标。LEADING 是省前零（补后 0）、TRAILING 是省后零（补前 0）、NONE
是不省 0（前后均补 0） 

例：025690 省前零为：25690 (Leading)  
025690 省后零为：02569 (Trailing) 
025690 不省零为：025690 (None) 

单位： 

METRIC（mm） 

ENGLISH（inch or mil） 

单位换算： 

1 inch ＝ 1000 mil ＝ 2.54 cm ＝ 25.4 mm 

1 mm ＝ 0.03937 inch ＝ 39.37 mil 

GERBER 格式的数据特点： 

数据码：ASCII、EBCDIC、EIA、ISO 码，常用：ASCII 码。 

数据单位：英制、公制 

坐标形式：相对坐标、绝对坐标，常用：绝对坐标。 

数据形式：省前零、定长、省后零，常用：省前零。 

GERBER FILE 极性介绍： 

正片（POSITIVE），负片（NEGTIVE） 

线路层，指铜箔部分；正片底片上铜箔是黑色的，负片底片上铜箔是透明的。 

阻焊层，指不上绿油部分（即上锡部分）；正片底片上此部分是黑色的，负片底

片上此部分是透明的。 

文字层，一般都是正片，文字、器件框等底片上是黑色的。 

复合片（COMPOSTIVE） ：GERBER 所描述的层次由不同极性层合成。通常是挖层

和正极性层叠加。 

挖层极性为 CLEAR 

 

 

CAM350 钻孔介绍 
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16 
一、钻孔档（Drill File）介绍 

常见钻孔及含义： 

PTH - 镀通孔：孔壁镀覆金属而用来连接中间层或外层的导电图形的孔。 

NPTH - 非镀通孔：孔壁不镀覆金属而用于机械安装或机械固定组件的孔。 

VIA - 导通孔：用于印制板不同层中导电图形之间电气连接(如埋孔、盲孔等)， 

但不能插装组件引腿或其它增强材料的镀通孔。 

盲孔：仅延伸到印制板的一个表面的导通孔。 

埋孔：未延伸到印制板表面的导通孔。 

常见格式： 

DRL   TXT    

坐标格式： 

LEADING ZERO SUPPRESS：坐标整数字前面的 0 省略，小数位数不够以 0 补齐。 

TRAILING ZERO SUPPRESS：坐标小数字后面的 0 省略，整数位数不够以 0 补齐。 

NONE ZERO SUPPRESS：整数和小数位数不够均以 0 补齐。 

FORMAT（小数点之隐藏与否） ：共有十种格式。 

二、钻孔盘(DRILL RACK)介绍 

主要描述钻孔档中用到的钻头大小，有的还说明孔是 PTH 或 NPTH。 

钻孔盘一般以 M48 开头，排列在钻孔文件的前面。也有单独以文件说明。 

DRILL RACK＋DRILL FILE＝完整的钻孔图形 

常用字段： 

Tool ：钻头编号 

Size ：孔径大小 

Pltd ：PTH 或 NPTH 说明 

Feed ：下刀速 

Speed ：转速 

Qty ：孔数 

三、镜头档（Apeture File）介绍 

镜头档主要描述相应 Gerber File 所用镜头之形状和大小。 

Apeture File + Gerber File =完整的 PCB Layout 图形。 

常用字段： 

D_Code：D 码，即镜头编号 

Shape：镜头形状 

Size：镜头大小 

 

 

常用的 D Code 及功能 

D 码是绘图形状大小的控制码。 

* 命令结束符 

D01 画线命令 

D02 只移动位置而不曝光胶片的命令 

D03 闪烁命令 

D00 回复到原来的预设的坐标位置 

D04 提起绘图笔, 并做快速移动。 

D05 结束 D04 的功能。 
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17 
D10～D999： APETURE CODE 

 

 

常用的 G Code 及功能 

Ｇ码是用于绘图机的动作控制码。 

* 命令结束符 

G01 画直线命令 

G02 顺时针画圆弧 

G03 逆时针画圆弧 

G04 注解命令 

G54 更换镜头 

G70 英寸 

G71 毫米 

G74 取消用 360°的画圆功能, 恢复成以 1/4 圆弧的绘图方式 

G75 启用 360°的画圆功能 

G84 用大孔直径 1/3 左右的钻头在 XnYn 处钻直径为 M 的大孔 

G85 在 XnYn 和 XmYm 之间钻 SLOT 

G90 绝对坐标 

G91 相对坐标 

G00 关闭快门 

G20, G21 顺时针方向画圆 

G30, G31 逆时针方向画圆 

G36 启用 area fill 的功能 

G37 关闭 area fill 的功能 

 

 

常用的 M Code 及功能 

M 码是绘图资料的参数码。 

* 命令结束符 

M00/M01/M02 文件结束 

M03 结束磁带的程式或回带 

M08 结束重复指令 

M25 重复指令中定义块首，单独使用 

M30 结束刀具指令 

M48 带头指令，单独使用 

M64 设定图档的原点位於绘图机的现在位置并继续绘图 

M80 M90 在程序零位镜像 XnYn 反转图形 

M97 在 XnYn 位置沿 X 轴钻字：TEXT 

M98 在 XmYm 位置沿 Y 轴钻字：TEXT 

 

文件处理步骤 

 钻孔 内层线路 外层 阻焊 字符   操作过程中要多手动 SAVE 

 拿到客户数据后先检查资料是否齐全，有无制板特殊工艺要求 

 导入客户原稿，并保证是正确的，整层对齐，移到 0点，保存原稿数据。CAM350 
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18 
的 PCB 文件（可以 YWJ-型号来命名）和相关 GBR 和钻孔数据。 

 对钻孔层做 CHECK DRILL 和优化（检测重孔、偏心孔、孔距近的，删除重孔

和偏心孔，对孔距近的向接单者反馈是否允许移动再操作）。 

 整层对齐,线路上钻孔盘和贴片转为 PAD 形式 

 做 Snap Drill to Pad 微调孔与 PAD 对齐 

 定义好各层(GBR 和 DRL、外形层)的属性后,全选生成网络。 

偏心的孔是无法生成网络的！只有正确生成网络，才能得出正确的 DRC 报告！ 

 做 DRC 检测：线路层 T 线-T 线，T 线-P 盘，P 盘-P 盘距离，最小盘，最小

线径，Drill-pad 环宽（钻孔后剩下的铜环，避免破盘），是否达到厂内制程

能力，优化后能否达到。检测钻孔是否有重孔（同心孔、偏心大套小孔），

孔距不够的。如有不能优化达到厂内制程能力的情况先向接单人提出。 

 

 

 对线路进行线宽补偿，加大 PAD 保证环宽 

内层线路需要保证花盘内径（即连接盘的环宽）及始终有 0.2mm 通路，隔离盘（非

连接盘足够大），内层信号层需删除孤立 PAD。非孔化孔都必须有隔离盘。 

内层地电两层同一处 PAD 不能都是花盘；电阻、电容的两个引脚不可能都是花盘；

如是就造成短路！内层需保证到外形有足够安全距离，避免铣外形铣小造成网络

短路和断路。与原稿校对保证与客户设计意图一致。 

 外层线路上还需删除 NPTH 孔处盘 

用外形加大切割线路，保证线路到外形的安全距离（    ）mm 

根据 DRC 检测结果，不达标处再修正，如移线，加大 PAD 保证环宽，应客户要求

加泪滴，填细缝，切割间隔，直到 DRC 检测后全部达标。 

与原稿校对保证与客户设计意图一致。 

 阻焊，一般根据处理后线路层上 PAD 加放生成，并加上原有数据的光学点，

锡条，锡块，NPTH 孔的阻焊。并与原稿校对。做 DRC 检测，检查阻焊到线路

间隔，绿油桥。不满足处修正。与原稿校对保证与客户设计意图一致。 

 文字，检查文字最细和高度最低，文字框到阻焊间隔是否都达到制程能力，

文字是否上盘，不满足处修正（包括移动文字），添加厂商标识，UL， Datecode

等，且不可加在零件区域和文字框内（除非有特殊说明）、也不可加在被钻

到、冲到或成型的区域。然后用阻焊和外形加大去挖文字层。与原稿校对保

证与客户设计意图一致。 

 客户有特殊要求或 PCB 无文字层时，UL MARK 和 DATE CODE 标记可用铜箔

蚀刻方式蚀刻于 PCB 上（在不导致线路短路或影响制板成品率的情况下）或

直接用镂空字加在防焊层上。 

 单块处理完，保存单块 CAM 后的 CAM350 PCB 文件（可以型号-EDIT-1 命名） 

 进行虚拟排版，添加工艺边，工艺导线，定位点，光学点，客户料号过 V-CUT 

的要导 V-CUT 角（Edit-->Line Change-->Fillet，如果需导圆角则用下述

命令：Edit-->Line Change-->Chamfer）。加 V-CUT 测试点、钻断孔、二次

钻孔、防呆测试线和 PAD、识别标记等。加完保存拼板 CAM 后的 CAM350 PCB

文件（可以型号-PB 来命名）并输出光绘数据和钻孔数据。输出后需重新调

入验证输出是否正确，特别是复合层数据。 

 输出前需打散所有宏 D 码（EDIT，CHANGE，EXPLODE，CUSTUM，ALL） 

 


